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Abstract 
With the purpose of lessening the software production efforts in computer 
networks area, the use of tools that help the system specification and 
implementation process is needed. This work presents a development tool based 
on the NSOMA methodology, intended to help the designers in the formal 
definition of specifications. It is composed of a graphical editor, an animation 
module that allows the visualization of specification dynamic behavior and a 
source code automatic generating module. 
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INTRODUCTION 

The use of tools for developing software is currently a fact, due to advantages 
such as reduced production time and easy system maintenance, documentation 
and expansion. The use of a number of features available for each tool provides 
help for the various stages of software developing. 

There are many system specification and implementation environments 
designed for computer networks. Most designers, though, still use primitive, user
unfriendly methodology, as these environments are usually based on complex 
Formal Description Techniques (FDTs) (Cohen, 1986). An Object Orient 
Specification Tool (OST) has been developed at Federal University of Rio 
Grande do SuI bearing this difficulty in mind. OST associates a modeling and 
developing methodology to a formal specification technique. This tool allows 
better comprehension and organization of the system components and thus 
becomes a very efficient way to produce easy-to-use tools regardless of the 
programming language they are based on, whieh are only a few and mastered by 
few designers. 

OST is based on the Network System Object Modeling Approach (NSOMA) 
(see item 2 below), integrating object-orientation concepts to SDL (Specification 
and Description Language). OST is composed of three modules: a graphic editor, 
which allows creating and editing a specification from NSOMA's graphic 
grammar, an animation module, which provides instruments to visualize the 
dynamic behavior of the specifications, and an automatic source code generator. 
These modules are presented in sections 3, 4 and 5, respectively and section 6 
introduces an example. 

2 NETWORK SYSTEM OBJECT MODELING APPROACH 
(NSOMA) 

The goal of NSOMA is to make SDL easier to use, associating it to the object
orientation paradigm under the Object Modeling Technique (OMT) method 
(Almeida. 1994) (Rumbaugh. 1991). As the human mind can see the world as a 
series of inter-related objects, the use of this concept furthers comprehension. 
Thus. the real world is brought closer to the computing world. It also allows the 
possibility of reusing previously developed entities in the creation of new 
software. 
Because NSOMA specifications are hierarchically defined. this approach is 
broken into three specification levels. These levels allow the designers to start 
from a more abstract level and then refine their specification. bringing it closer to 
the implementation. 
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The following are NSOMA specification levels: 
• Abstract structural level: at this level, classes' behavior and relations are 

determined. 
• Detailed structural level: at this level, each class's behavior is determined. 

Ports, internal signals, attributes and operations are defined. 
• Operation level: at this level, each previously defined operation is detailed. 

The abstract structural level description is based on OMT concepts. It allows 
the definition of highly abstract classes that form a network system and the 
relations between them. Their corresponding objects represent elements of a 
network system - protocols, functions, services, entities. These classes are 
described and identified by their type, name, attributes and operations. 

A class can be defined from another's definition. In such case, one says the first 
inherits from the second and calls it a subclass, which may inherit attributes and 
operations from the parent class totally or partially. In addition, a class can be 
defined as a combination of other classes, though preventing the latter from 
inheriting attributes or operations from the former. A class can inherit classes that 
were defined by combination. In such case, the subclass inherits all classes that 
compose the parent class. 

The detailed structural level is where attributes, operations and internal signals 
are actually defined for a given class. Every class modeled at the abstract 
structural level is refined at the detailed structural level. The internal signals 
allow communication between operations of the same class. They can be 
synchronous or asynchronous. 

Ports and external signals supply communication between elements of different 
classes. It can also be synchronous or asynchronous. Communication is 
considered synchronous when the source operation enters a hold state for a 
response signal, thus being blocked indefinitely. whereas asynchronous 
communication does not hold and therefore is not blocked. External signals are 
detined outside classes' behavior. which allows their further individual use. 

The operation level allows every previously defined operation to have its 
behavior diagramed, thus determining the system's control flux. Hierarchically. it 
is the closest level to implementation and it is strongly based on SOL. 
Graphically. this level is described by diagrams that represent a state machine of 
the operations. 

3 THE GRAPHIC EDITOR 

This editor implements all functions necessary to system specification in 
NSOMA. The software uses NSOMA's graphic syntax to help the user interact 
more naturally. Specifications are created through the manipulation of the 
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grammar graphics (Gaspary, 1995) (Granville, 1995). The textual approach is not 
neglected, though, allowing the user to textually visualize the specifications being 
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built. Figure 1 shows the tool's main interface. 

Figure lOST's graphic interface 

From the File menu, the user can create new specifications, load pre
existent specifications from a database, save specifications onto database as 
well as retrieve classes from a class library. From the Edit menu, objects 
can be selected from the editor and copied to Windows transfer area, which 
can prove helpful to documentation using other software. The ASL, DSL, 
OL and ES menus are used to select symbols corresponding to each of 
NSOMA's levels. Animation and Generate Source Code start operations 
from their respective modules, which are presented below. Finally, Window 
and Help have window management functions for OST, which are standard 
to Windows applications. 

The upper toolbar provides quick access to the most commonly used 
functions. It accesses these functions: creation of a new specification, 
loading and saving an ongoing specification, deletion of selected symbols 
and their copy to Windows transfer area, reading the external signals 
diagram and help. 

To start a new specification, select New from the File menu or click on 
the corresponding icon on the toolbar. That will open a window 
representing the abstract specification level. On the upper left corner the 
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words Key and Describer can be seen, without any links to text. Also, four 
buttons on the left become active. These are the functions that can be used 
at this level. To create a new class, for instance, click on the class button 
(1) of figure 1. Next, use the mouse to insert new classes in the window. 
Initially, the application will automatically generate names and types for 
the classes in order to avoid repetitions. 

To include a class from the library in your specification, select Load 
class from the File menu. A dialog box will display all library classes so 
that one can be picked. The chosen class is then loaded from the database 
and included in the diagram. 

Buttons (3) and (4) on figure 1 allow the representation of class relations. 
Click on the corresponding button and then on a class graphic to create a 
line that represents a relation between two classes. 

Finally, button (2) brings the user back to selection mode. Using this, the 
user can move the graphics on the screen by dragging them. Also, many 
objects can be selected simultaneously and then moved, copied to the 
transfer area or deleted. 

Figure 2 shows the active menu for a class Class3. This class can have its 
name and type changed, as well as some graphic features of inheritance and 
composition. 

Figure 2 Context-sensitive menus 

The last option of the menu starts edition at the detailed structural level . 
Double clicking on a class also starts this function . 

Accessing the detailed structural level opens a new window. New 
buttons are activated on the left, disabling the buttons for the previous 
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level. This new level enables functions for creating operations, internal 
signals (7), external signals (8) and attributes (6), shown in figure 1. The 
manipulation of objects follows the same pattern for manipulation as the 
abstract level. 

NSOMA's last level is accessed by double-clicking an operation, the 
same pattern used to access the detailed level. Once again, the left-hand 
tool bar is updated to show the options valid for the current operational 
level, as shown in figure I. 

At any level, a specification's textual description can be read. To do that, 
select this option from the menu in the corresponding level. The text is 
presented in a new dialog box. This cannot be altered, though, in order to 
assure consistency with the graphic specification. 

To include all these functions in the editor, an object-oriented 
programming approach was used to build it. The basic classes that were 
implemented can be divided into two separate groups, database class and 
graphic class (Trainini, 1995). The database classes (Data_ob) are 
responsible for the semantic consistency of a given specification (see figure 
3). Each new element added to the diagram is actually a database object. If 
it cannot be created, some database rule violation can be assumed. Further 
information on how database elements interrelate to keep specification 
consistency can be found in (Gaspary, 1995) (Granville, 1995). 

On the other hand, the graphic classes are responsible for the 
implementation of all graphic functionality. There are basically a window 
class (TDragDropWilldow) and a graphic object class (TShape). These two 
primitive classes work together to implement drag-and-drop and multiple 
selection functions, among others. Window classes for each specification 
level were derived from TDragDropWilldow. All graphic symbols used in 
the editor were derived from TShape. 

The basic classes are divided into two separate groups for the sake of 
comprehension. Actually, there is high interaction between the two groups. 
In fact, any graphic element is a database object and a graphic object at the 
same time. It must be consistent to its specification as well as have all the 
necessary graphic functionality. 

The basic classes, in their tum, are also derived from a library set (OWL, 
which accompanies Borland C++). OWL contains many of the required 
features. Figure 3 shows a general map of the classes used by the editor. 
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Orag&Drop 

Figure 3 Set of classes for the OST editor 

4 ANIMATION MODULE 

The animation of a system's dynamic behavior is a basic need to its definition 
and specification (Allende, 1995). It fosters the understanding of the description 
being specified, translated as reduced construction cycles since a number of 
problems can be verified during the early development stages (Verilog, 1994). 

OST provides an environment to visualize animation, in addition to plenty of 
statistic data and some deadlock-detection facilities . This kind of functionality 
can be found in verification systems. 

The animation was implemented using, basically, symbols from the operational 
level and operation representation structure (Gaspary, 1996). The animation 
controls were implemented in two new classes called AnimOL_Sym and 
AnimOperation, which relate to the editor's structure as seen in figure 4. 
AllimOL_Sym associates every animation-relevant symbol to a count variable, in 
order to provide statistics on the use of this symbol. Also, it has a drawing 
method for the symbol being run, so that it can be highlighted. AnimOperation 
implements an input signal queue for each operation, which keeps the signals 
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from being lost. Using the same pattern as for symbols at the operational level, a 
drawing method for the highlighted operation symbol should follow. 

Figure 4 AnimOL_Sym and AnimOperation classes 

Figure 5 shows how the animation works. Every operation of a given 
specification is pointed by a control entity. The figure shows a semaphore 
composed of two operations (master and slave) (Verilog, 1994]. This entity points 
at the initial symbols of each operation, and then to their subsequent operations, 
according to given navigation options. 
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Figure 5 Visiting tree of a given specification 

OST's animation provides the foIlowing operations: Start, Next Step, Previous 
Step, Auto, Next Stop and Stats (Eijk, 1988). 
I. Start: sets the animation environment and enables the Next Step operation. 
2. Next Steps Menu: show actions that can be started. When this menu cannot 

be enabled, that means, when no operation can offer a transition to be started, 
the animation will have reached a deadlock state and therefore cannot be run 
any further. A message wiJI inform the user of any such case. 

3. Next Step: aIlows the start of a new transition in the animation. After the 
menu is built, the user is expected to interact with the system by indicating 
which transition should be started. 

4. Previous Step: aIlows reversing one or more steps of the animation. It gives 
the opportunity to test many execution alternatives, though preventing the 
need to restart the whole process repeatedly. 

5. Auto: runs the animation automaticaIly, with no interaction with the user. 
Therefore, the system should be informed about the conditions to halt the 
animation. This conditions are linked to a certain number of iterations over a 
symbol or to a set run time. Of course, deadlocks will also halt the execution. 

6. Next Stop: combines interactive and automatic execution. It aIlows the 
animation to be automatized to a point where a decision has to be made. 
Then, the user will choose which action to take. 

7. Stats: these can be checked during or after the animation, presenting 
information such as: 
• Elapsed time: shows elapsed during animation. 
• Unvisited symbols: a very useful option, as it shows dead code in the 
specification. It can be expanded to show whole-unused paths. 
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• Potential /ivelock points: extensively visited points can be thought of as 
livelocks. 
• Total visited symbols: general overview of the total visitation. 

The functions available in the animation module enable a larger and clearer 
view of the specification being developed. Furthermore, the user can assess 
specific situations and decide if they perform as expected. 

5 CODE GENERATOR 

The language hierarchy provides instruments for automatic code generation 
(Froberg, 1993). The classes defined at the abstract structural level are mapped to 
C++ classes. Each defined class is coded in a separate module, containing the 
definition of the operations and attributes that are converted, respectively, into 
functions and variables. 

When a class is initialized, each operation is run as a process and its descriptor 
is stored as an internal attribute to the class, like user-defined attributes. The 
ports, in their tum, become the methods visible externally to the class. Each 
method receives messages from external operations to the class and forwards 
them to their corresponding destiny processes. 

The datagramJwlction in figure 6 shows the code generation. As we see, each 
port is mapped to a method that will be used to provide communication with 
other classes. Similarly, figure 5.2 shows operation receive receiving a signal a. 
The class's constructor initializes its operations in separate processes. Finally, 
each operation is defined from a state machine, in non-structured source code. 

class datagram_function { 
private: 

public: 

}; 

Figure 6 datagramJunction class 

process_handle receive; 
process_handle encode; 
void Receive (void); 
void Encode (void); 

void a (signal_list); 
void b (signal_list); 
void d (signal_list); 
void e (signal_list); 
void f (signal_list); 
void g (signal~list)1 
datagram_function (void); 
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b~ ~clve )I---I.~( Enc~ ~ 
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datagraa_function::datagram_function 
(void) 
{ 

receive • create-process 
(Receive); 

encode • create-proces5 
(Encode); 
) 

void datagraa_function::a(signal_list 
signal) 
{ 

dispach_message (receive, 
signal) J 
) 

Figure 7 datagramJunction class's operations 

6 EXAMPLE - THE HTTP PROTOCOL 

The figure 8 shows the diagrams resulting from the HTfP Protocol Specification. 
It's an incomplete high level description, where details were neglected in order to 
have a more didactic example. 

The protocol is designed as two distinct classes named Server and Client, each 
of them inheriting the classes corresponding to the HTTP previous version. HTTP 
first versions define just simple requests, which are less complex than the current 
one. So, inheriting such definition is a fast way to design more complex 
specifications. 

The client class has an operation named Request, which creates and sends 
HTTP messages to the server side and waits for the server response. Messages are 
sent and received via ports (in the example In and Out). Such ports are showed in 
the Fine Structural Level diagram and are placed next to the corresponding 
operation. The behavior of Request is defined in the Operational Level that is 
quite similar to an ordinary standard SDL diagram. The messages exchanged by 
classes are done by means of external ports and the associations of them are 
defined in the External Signals diagram. 



326 Part Eight Specification 

Floe Structural Level 

HTlP 
SeJ'tCr 

SeJ'tCr 

~ -
HTTPIIl 
Server 

Server 

( Client J 

Figure 8 HTIP protocol example diagrams 

7 CONCLUSIONS 

OST is a very powerful specification tool. It provides any users, either computer 
networks programmers or information systems designers, with a tool based on a 
standard FDT, such as SDL, and then improves this tool using an object-oriented 
paradigm, which is known as a potential productivity booster in software 
development. 

The many modules that form OST offer a more efficient way to specify 
systems. Its editor allows the creation of a specification using NSOMA's graphic 
grammar, furthering comprehension and interaction. OST's on-line syntax check 
avoids user errors. In addition, classes can be reused, which makes the 
construction process ever evolving, incremental, fast and efficient. Under the 



OST - an object-oriented computer networks system specification tool 327 

computer networks area jargon, classes can represent the basic concepts of 
model, layer, protocol, service and entity. 

OST's animation feature increases comprehension of the systems developed. 
This is fundamental for a software developing team where a single and clear idea 
of what is being done is a must. Also, errors associated to the dynamic behavior 
of the specification (deadlocks and Iivelocks, for instance) can be detected. 
Furthermore, automatic code generation avoids the manual codification of a 
whole system. Consequently, the source code is free of lexical and syntactical 
errors. 

OST can be further expanded, including specification verification and 
validation mechanisms that will assure even better correctness. Even though the 
editor is syntax-oriented, no lexical consistency is performed. This reflects on 
source code generation, which becomes undesirably linked to errors from the 
specification stage. Such lexical consistency is also to be included in future 
expansions. 
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